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Introduction to Developer Source
Welcome to Developer Source, the quarterly CD-ROM library containing over 40 leading 
software development magazines, journals and industry reference books.      Developer 
Source includes a powerful information retrieval system that helps you retrieve the text and 
images that you are looking for.    Here are some BASIC CONCEPTS that you need to know 
maximize your use of Developer Source:

Developer Source offers TWO PRIMARY WAYS of RETRIEVING INFORMATION:    

1. BROWSING:    Using the Table of Contents you can browse through each of the 
publications, by year, issue, and article title.    In addition, by clicking on CROSS REFERENCES
you can browse code listings that are referenced in the articles.

2. SEARCHING: also called EXPRESSION-SEARCHING: The retrieval software finds all 
occurrences of a word or phrase or number.    A search-expression, regardless of whether it is
a word, a phrase, or a number, is called a KEYWORD.    When you ask find two or more 
keywords, they are linked by the terms AND, OR, or AND NOT.    These are called BOOLEAN 
search terms.    

Sometimes you want to search the entire library and other times you may want to search 
only specific subsets of the library-- this is called DOMAIN SEARCHING. Developer Source 
allows you to define your own domains.    

Other times you may want to search for a keyword only in a "data-field", such as the data-
field called "author" rather than searching for all occurrences of a keyword anywhere in the 
library.    This is called FIELD SEARCHING.

ADDITIONAL FEATURES AND FUNCTIONS

Developer Source separates text from images.    This allows you to look at images at the 
same time as you are reading the text.

Developer Source actually lets you do MORE THAN FIND INFORMATION AND READ IT; it 
allows you to:

- COPY: copy selected text and images for pasting into other software applications.

- PRINT: print selected text and images

- ANNOTATE: place annotations on text.

- BOOKMARK: place a bookmark on a specific text location.

- CHANGE DISPLAY: change color attributes of annotations, keywords, cross-references; 
and chose preferences for text display.

A "session" of browsing and searching a database is called an INVESTIGATION. During an 
investigation, a log is automatically kept of the documents browsed, all the search 
expressions you used, and all the cross-reference jumps you made.    

You will notice in the menus that some of the commands have control-key codes to the right 
- - these are the hot key combinations. These keystrokes (always beginning with the control 
["CTRL"] key) make interacting faster than using a mouse. They can be used for frequently 
repeated actions.



 



Introduction to the FILE Menu

The File menu commands control file manipulation functions.    These include:

- starting, saving, and deleting INVESTIGATIONS (special files that log all the browses, 
searches, and reference-jumps you make during a session)

- printing documents, text, and images.



Starting a New Investigation (the New Command)
You can start a new Investigation at any time.    To do so, 

1.    Select the File menu.    

2.  Choose the New command.

The New command creates a new Investigation with no information about earlier activities in
it. Developer Source opens at the first document in the database.

If you attempt to start a new Investigation without saving the current Investigation, 
Developer Source asks whether you want to save the current Investigation information, as 
shown below.    If you do not save the current Investigation, the information that it presently 
contains will be lost.

You can respond to the message box above in one of three ways:

-    To save the contents of the current Investigation before proceeding to the new 
Investigation,    choose Yes.

-    To establish a new Investigation without saving the current Investigation, choose No. 

-    To abort the saving process and the new Investigation, choose Cancel.

If the current Investigation is unnamed, and you attempt to save it, Developer Source 
responds with a dialog box in which you specify an Investigation name.    In response, enter a
name for the current Investigation (the Investigation you are leaving) and choose the OK 
button, or choose the Cancel button to abort the process of starting a new Investigation.



Opening an Investigation (the Open Command)
To open or restore an Investigation that you have saved, 

1.    Select the File menu.    

2.    Choose the Open command.    The Open Investigation dialog box appears.    The text 
field, preceded by the phrase "Path" identifies the current directory.    

3.    Open or load a new Investigation from the current directory in one of the following 
two ways:

If you know the name of the Investigation file that you want to open, enter the 
name of the file in the text box, located at the top of the dialog box.    The text box 
contains the currently selected entry from the list box.    After you have entered the 
name of the Investigation file, choose the OK button to open the Investigation.

If you do not know the name of the Investigation file that you want to open, 
use the vertical scroll bar to scroll through the Files list box until you find the file that 
you want to open.    When you have located the Investigation file that you want to 
open, choose the OK button.

*Note that the Files list box contains all Investigation files in the current directory (files
with the specification .INV unless designated otherwise).    In addition, the Directories 
list box contains the available disk drives, the names of any sub-directories below the 
current directory, and the entry [..] indicating a higher directory, the parent directory.   
By selecting these items, you can search for Investigation files in directories on other 
disk drives and in directories above and below the current directory.

After you choose the OK button, Developer Source either restores the selected Investigation 
just as it was when you last saved it, or prompts you to save the current Investigation (the 
Investigation you are leaving) before opening another.    If you choose not to save the current
Investigation, the information that it presently contains will be lost.    



Saving an Investigation (the Save Command)
After you have performed various research activities within an Investigation, you may want 
to save the Investigation so that you can return to it later with all changes and 
accomplishments (search results, annotations, and so on) intact.    

To save the changes that you have made during the current session, 

1.    Select the File menu from the menu bar.

2.  Choose the Save command.    This command saves information within the current 
Investigation--the Investigation that you have reopened or named during the current 
session.

If you choose the Save command without having named the current Investigation, the 
system prompts you for a name.    To save the Investigation, enter an Investigation name 
and choose the OK command or, to abort the saving process completely, choose Cancel.



Saving an Investigation Under a New Name (the Save As 
Command)
The Save As command allows you to save your current work in a named file, whether that 
file is new or is already present on the system (in case you want to overwrite the file).    

To save an Investigation under a new name, thereby creating a new Investigation, 

1.    Select the File menu.    

2.    Choose the Save As command.    A dialog box appears prompting you for an 
Investigation name.

3.    To save the Investigation, enter an Investigation name at the prompt and choose OK,
or, to abort the saving process completely, choose Cancel.

After you have named the Investigation, Developer Source stores the new name and uses it 
for any subsequent saves.



Deleting an Investigation (the Delete Command)
Developer Source allows you to delete or eliminate any Investigation that you no longer 
want to keep. 

 To delete an Investigation, 

1.    Select the File menu.    

2.    Choose the Delete command.    The Delete Investigation dialog box appears.    The 
text field, preceded by the phrase "Path," identifies the current directory.    

3.    You can delete an Investigation from the current directory in one of two ways:

-    If you know the name of the Investigation file that you want to delete, you 
can enter the name of the file in the text box, located at the top of the dialog box. 
The text box contains the currently selected entry from the list box.    After you 
have entered the name of the Investigation file, choose the OK button to delete 
the Investigation.

-    If you do not know the name of the Investigation file that you want to 
delete, use the vertical scroll bar to scroll through the Files list box, which 
contains all Investigation files in the current directory (files with the 
specification .INV unless designated otherwise).    When you have located the 
Investigation file that you want to delete, choose the OK button.

Note that the Files list box contains all Investigation files in the current directory 
(files with the specification .INV unless designated otherwise).    In addition, the 
Directories list box contains the available disk drives, the names of any sub-
directories below the current directory, and the entry [..] indicating a higher 
directory, the parent directory.    By selecting these items, you can search for 
Investigation files in directories on other disk drives and in directories above and 
below the current directory.

4.    After you choose the OK button, a confirmation message box appears.    To confirm 
that you want to delete the file listed, choose the OK button.    

Developer Source removes the selected Investigation from the list and deletes from the 
system all information relevant to the Investigation.



Printing both Text and Images (the Print Command)

Printing Text

Developer Source enables you to print marked database text, the current document, the 
current page, the Audit Trail (discussed in Using the Assists Menu Commands), and search 
results.    You can send printer output to a device on your system as well as to a named file.

To print database text or an associated item, 

1.    If you want to print marked text, mark the text that you want to print (using standard
Windows conventions) or, if you want to print a document or the current page, place 
the cursor anywhere on the text.

2.    Select the File menu.    

3.    Choose the Print command.    The Print dialog box appears. 

4.    From the Select section, choose the item--marked text, document, current page, 
audit trail, or search results--that you want to print. 

5.    Move to the Output To section listing devices that can be used as output media.    

6.    Select an output device from the list in the Output To section.    Two output devices 
are available within this version of Developer Source: printer and file.

7.    If you choose the File command, Developer Source places a cursor in the text box 
immediately to the right of the entry.    In the text box, enter the name of the file to 
which you want to sent printer output.    If the file already exists, Developer Source 
presents a dialog box asking you to overwrite the file, append this new output to the 
file, or cancel the procedure.

8.    To print header information with the item, check the Headers check box.    Header 
information consists of the current time and date entered at the top of each printed 
page.

9.    To print footer information with the item, check the Footers check box.    Footers 
consist of the current page number centered at the bottom of each page and the 
phrase "Continue..." at the bottom, right side of every page except the last.

10. Choose the OK button.    The system displays a message box identifying what is 
being printed and providing an option to cancel the printing.    Developer Source 
displays this message box until the system has sent the print manager all information 
to be printed.

Printing Images

Developer Source enables you to print all or part of any image in your database and to save 
the contents of the entire image in a file.    You can send printer output (information to be 
printed) to any device on you system that has a device driver with graphics capability.    If 
the image is displayed with inverted colors or in reverse video (white on black becomes 
black on white and vice versa), the image is also printed with inverted colors (see the Page 



menu commands).

To print or save the entire current database image, (full image)

1.    If the image window is not active, select the image window to make it active.

2.    Select the File menu.

3.    Choose the Print command.    The Print dialog box appears.

4.    From the Select section, select the Full Image option button.

5.    Send output to the printer or to a file, as described below:

-    To send output to the printer device, select the Output to Printer option 
button, or press ENTER (sending output to the printer is the default).

-    To save output in a file, select the Output to File option button.    A dialog box 
appears, into which you enter the name of the file that will contain the current 
image output.

6.    If you prefer that Developer Source save the image in uncompressed format, click 
the Uncompressed check box at the bottom of the Print dialog box.    Otherwise, 
Developer Source saves the image in compressed format.

7.    Choose the OK button to print or save the current database image in its entirety.    If 
you chose to send output to a printer device, the image is sent to the print spooler, 
scaled to fit the size of the printer paper, and then printed.    If you chose to send 
output to a file, the image output is saved in the file that you specified.

To print the current database image, (partial image)

1.    If the image window is not active, select the image window to make it active.

2.    Select the File menu.

3.    Choose the Print command.    The Print dialog box appears.

4.    Select the Current Image option button.    Note that when you select    this option 
button, the Output to File option button becomes inactive.

5.    Choose the OK button to begin printing the current database image.    The image is 
sent to the print spooler, scaled to fit the size of the printer paper, and then printed.

NOTE:    If you are printing a partial image and want a what-you-see-is-what-you-get 
reproduction, the image window should be the same general shape (height and 
width) as the printer paper.    Printing always starts in the upper left corner of the 
window, but does not always end in the lower right corner.    When printing the full 
image, window shape does not matter.    If you want printouts to be greater in width 
than in height, use the Microsoft Windows Control Panel application to set the printer 
to landscape mode.



Changing Output Devices or Printers (the Change Printer 
Command)
The Change Printer command allows you change printers or output devices so that you can 
configure Developer Source to fit your own system.    Developer Source supports all output 
devices supported by Microsoft Windows. 

 To send output to a different output device, 

1.    Select the File menu.    

2.  Choose the Change Printer command.    Developer Source displays a dialog box listing
all output devices known to your system.    

NOTE:    Each entry in the list box is an output device that has been installed with 
Windows during setup or an output device installed with the Add Printer 
command in the printers dialog box within the Control Panel.

3.    Use the vertical scroll bar to scroll through the list box until you locate the output 
device that you want.    

4.    Select the desired output device.

5.    Choose the OK button to make this output device active.    

6.    If the output device you have selected has options for its mode of operation, a dialog
box appears presenting these options.    Select the options that you want with the list 
boxes and option buttons, and choose the OK button.

Printer output is now directed to the new output device.



Exiting Developer Source (the Exit Command)
To exit the Developer Source software and return to the Windows environment, 

1.    Select the File menu.

2.    Choose the Exit command.    

If you have made changes in the current Investigation since last saving it, a message box 
appears prompting you to save the current Investigation before terminating.    You can 
respond to the message box in one of three ways:

-    To save the current Investigation before exiting Developer Source, choose Yes.    

-    To exit Developer Source without saving the current Investigation, choose No.

-    To abort the exiting process, choose Cancel.

If the current Investigation is unnamed when you attempt to save it, Developer Source 
presents a dialog box prompting you for an Investigation name.    In response, enter the new 
name in the text box and choose the OK button, or choose the Cancel button to abort the 
exiting process.

 



Introduction to the EDIT Menu
You cannot actually edit text or images on Developer Source -- the original integrity of the 
database is thereby maintained.    However, you can copy portions of text and images to 
other text-processing and image-processing software for editing.

The Edit menu contains commands that copy portions of text or images to the Clipboard and
that provide options for including document titles and date and time information with the 
information copied to the Clipboard.



Copying Marked Portions of Text or Image to the System 
Clipboard (the Copy Command)
The Copy command enables you to copy marked portions of text or an image onto the 
Clipboard.    From the Clipboard, you can move information into any application that runs in a
Windows environment and that supports copying information from a Clipboard.    You can 
mark as much text as desired up to 1 Mb limit of memory available for copying to the 
Clipboard.    Other limitations may apply based on restrictions of the application receiving the
marked text information.

To copy portions of text or an image to the Clipboard, 

1.    Mark the text or image that you want to transfer by using standard Microsoft 
Windows marking capabilities.    Note that marked text/image is displayed in reverse 
video.    

2.  Select the Edit menu.

3.    Choose the Copy command.    

After you execute the Copy command, the marked text/image becomes unmarked.    
If your system does not have enough memory to hold the contents of the marked 
text/image, a message box appears informing you of the problem.



Copying a Text Document (the Copy Document Command)
The Copy Document command enables you to transfer the contents of an entire text 
document into the Clipboard.    From the Clipboard, you can move the document contents 
into any application that runs in a Windows environment and that supports copying 
information from a Clipboard. 
 
The Windows Clipboard is limited to 1 Mb of information. If you attempt to copy a document 
and the system does not have enough memory to do so, a message box appears informing 
you of the problem.    In this case, "mark" and copy only part of the text you want; then shift 
to the other software program and "paste" the text from the Clipboard; then return to 
Developer Source, mark-and-copy more text.    Repeat these steps until you have copied 
over all the text you want.    Other limitations may apply based on restrictions of the 
application receiving the marked text information.

NOTE:    Whole images cannot be copied to the clipboard using this command.    The way to 
copy an entire image is to "mark" it completely, then use the Copy Marked Image command. 
However, there is a possibility that images may exceed the 1 Mb limitation of the Windows 
Clipboard.

To copy a document/image to the Clipboard,

1.    Place the blinking cursor anywhere within the contents of the text document or 
image that you want to copy.

2.  Select the Edit menu.

3.    Choose the Copy Document command.    If the cursor is not located within a 
document or an image, this command is disabled.

The Clipboard should now contain the entire document or image. If your system does not 
have enough memory to hold the contents, a message box appears informing you of the 
problem.



Stamping the Date and Time (the Stamp Date/Time Command)
The Stamp Date/Time command gives you the option of    including the current time and 
date in a box at the beginning of any document, text or image copied to the Clipboard.    

You may turn this option on or off at your own discretion.    Whether you resume an 
investigation or create a new one, the Stamp Date/Time option is not affected--it remains on 
or off until you explicitly change it.    A check mark identifies whether the option is currently 
in effect or turned on. 

To turn the option on, or conversely, to turn the option off, 

1.    Select the Edit menu.

2.    Choose the Stamp Date/Time command.

If the Stamp Date/Time option is selected, information copied into the Clipboard appears 
with the date and time included above the information copied.



Stamping the Document Title (the Stamp Document Title 
Command)
The Stamp Document Title command gives you the option of including the current document
header information in a box at the beginning of the text or image that is copied to the 
Clipboard.    The document header contains the complete hierarchical information (for 
example, the section of the database, publication, issue and title specifying the location of 
the information within the database) for the document.

You may turn this option on or off at your own discretion.    Whether you resume an 
investigation or create a new one, the Stamp Document Title option is not affected--it 
remains on or off until you explicitly change it.    A check mark identifies whether the option 
is currently in effect or turned on. 

To turn the option on, or conversely, to turn the option off, 

1.    Select the Edit menu.

2.    Choose the Stamp Document Title command.

If the Stamp Document Title option is in effect, information copied into the Clipboard 
appears with the document header included above the information copied.    If a document 
header is not available for the document copied to the clipboard, the message "No header 
information available" appears at the beginning of the text copied to the clipboard.

 



Introduction to the BROWSE Menu
The Browse menu contains commands that allow you to navigate Developer Source using a 
multi-level TABLE OF CONTENTS and by "jumping" forward and backward in the database 
via CROSS REFERENCES (used for jumping to code listings).



Using the Table of Contents to Browse Developer Source (the 
Table of Contents Command)

Developer Source enables you to browse the database through a multi-level table of 
contents, analogous to the table of contents found at the beginning of a book.    However, 
unlike a book's linear format, Developer Source's table of contents has a hierarchical format. 
You can view a list of magazines and journals, books and code listings contained on 
Developer Source.    Make a selection and you can see a list of the publications, issues and 
titles within that selection.

The following sections provide instructions for moving through the Table of Contents and 
jumping to desired text in the database. 

Moving through the Table of Contents

1.    Select the Browse menu.

2.    Choose the Table of Contents command.    Developer Source displays the Table of 
Contents dialog box.    This dialog box can be moved or re-sized as you prefer.

3.    Select Table of Contents entries to move through the various levels of the table of 
contents.    At the beginning (or left-most edge) of the table of contents entries, a (+) 
or (-) symbol indicates whether there are additional levels below the current level in 
the table of contents.    The actions that occur when you select entries with either the 
+ or - symbols are as follows:

plus (+)

If a (+) is present in the left margin of the table of contents window, Developer 
Source moves to the next level in the table of contents.    If the selected entry is a 
header entry (located at the top of the table of contents window), Developer 
Source moves to a previous level (a more general level or a listing above the 
current entry).    If the selected entry is a current-level entry, Developer Source 
moves to a next level (a subset of or listing beneath the current entry).

minus (-) 

If a (-) is present in the left margin of the table of contents window, Developer 
Source jumps to the text location indicated by the table of contents entry you 
selected.    Because no subheadings exist beneath this level of heading, Developer
Source proceeds to text.    We refer to the minus sign (-) as a "Go to Text symbol.

4.  Choose the Change Level button to move to the level that you selected in the 
previous step.    Note that if the currently selected table of contents entry is preceded 
by a Go to Text symbol (-), the Change Level button becomes disabled (grayed).

Moving to Text from the Table of Contents

1.    Move through the Table of Contents using the steps listed in the previous section to 
browse until you find the document or code listing (preceded by a Go to Text symbol 



[-]) that you desire.

2.    Choose the Go to Text button.    Developer Source removes the table of contents and 
jumps to the location specified by the entry you chose.



Using Cross References (the Cross Reference Command) 
As you browse Developer Source, Cross References can be especially helpful.    The Cross 
Reference command enables you to display information (usually code listings, tables or 
figures) associated with a particular reference within the text of the database.    You may see 
either new text or an image related to the term or phrase you decide to investigate.

Identifying a Cross Reference

Cross References are words or phrases that, when clicked on, take you to another part of the
database. Cross References are indicated by bold or italic and color fonts. 

Cross References are also recognized in one of two ways: 

-    Place the blinking cursor on a possible Cross Reference and check the Cross Reference 
command in the Browse menu.    If the word is not a Cross Reference, this command is 
inactive (grayed).

-    Execute the Cross Reference (according to the instructions in the following section).    If 
the word is not a Cross Reference, nothing happens.

Executing a Cross Reference 

You can execute a Cross Reference two ways:

-    Place the mouse cursor on a Cross Reference and double-click the left mouse button.

-    Place the blinking cursor on a Cross Reference and execute the Cross Reference 
command under the Browse menu.    



Moving Back One Cross Reference (the Back One Cross 
Reference Command)

As you execute successive Cross Reference commands to text locations (Code Listings), 
Developer Source keeps a log of the previous Cross Reference location.    The Back One 
command enables you to step backwards, one reference at a time, through the log of Cross 
Reference locations.

To move back one reference, enter the short-cut key sequence CONTROL + O or 

1.  Select the Browse menu.

2.  Choose the Back One command.    

Developer Source displays the text associated with the previous Cross Reference location.      



Moving Back to the First Cross Reference (Back All Command)
As you execute successive Cross Reference commands to text locations, Developer Source 
keeps a log of the previous Cross Reference locations.    After you have executed a series of 
Cross References, the Back All command enables you to go directly to the first Cross 
Reference location.    

To move to the first Cross Reference location, enter the shortcut key sequence 
CONTROL + A or 

1.  Select the Browse menu.

2.  Choose the Back All command.    

Developer Source displays the text associated with the first entry in the log of Cross 
References.    After you execute this command, the Back All command and the Back One 
command within the Browse menu    become disabled (grayed).



Browsing Through Images (Next, Previous, & Goto Page)
Sometimes you may encounter sequential images.    In this case, you may page through 
them much like paging through a book, using Next Page and Previous Page commands.    The
Goto command opens up a list of all the pages, from which you may select the page you 
wish to see.



Moving to the First Page of the Current Document (the First 
Page of Document Command)
The First Page of Document Command enables you to move to the first page of the current 
document.

To move to the first page of the current document,

1.    Select the Browse menu.

2.    Choose the First Page of Document command.

Developer Source displays the text of the first page of the current document.



Moving to the Last Page of the Current Document (the Last 
Page of Document Command)
The Last Page of Document Command enables you to move to the last page of the current 
document.

To move to the last page of the current document,

1.    Select the Browse menu.

2.    Choose the Last Page of Document command.

Developer Source displays the text of the last page of the current document.



Moving to the Next Document (the Next Document Command)
The Next Document command enables you to move to the next document in the database.    

To move to the next document, 

1.    Select the Browse menu.

2.    Choose the Next Document command. 

Developer Source displays the next document in the database.    



Moving to the Previous Document (the Previous Document 
Command)
The Previous Document command enables you to move to the previous document in the 
database (the document that immediately precedes the document currently containing the 
blinking cursor.--not necessarily the last document that you viewed).    

To move to the previous document, 

1.  Select the Browse menu.

2.    Choose the Previous Document command.

Developer Source displays the previous document in the database.    

 



Introduction to the SEARCH Menu
Developer Source's Search menu lets you search for information by constructing specific 
Search Expressions to locate information in the database.    The search commands allow you 
to construct a Search Expression by typing it in, selecting it from a Word Wheel, copying 
marked text directly from the database, or Pasting it in from some other software program.  
Developer Source also allows you to define a Domain, control how search Results are 
displayed and ordered, and to move through the database from one occurrence of the 
search Keyword to another. Developer Source also allows you to conduct Field searches.

Developer Source offers a very robust set of features for searching data.    If you are new to 
electronic searching, take some time and read this section carefully.



Creating an Active Search Environment (the Expression 
Command)

Understanding the Active Search Environment

Developer Source supports the notion of an "active search environment."    The active search
environment consists of three integral parts:    the current Search Expression, the current 
Search Domain, and the current results of the search execution.    These parts are preserved 
by the system and remain fixed until you change them.    At any point, you can change the 
active search environment through the Expression command within the Search menu.

To construct the active search environment, 

1.    Select the Search menu.    

2.    Choose the Expression command.    The Expression dialog box appears.

3.    Enter a valid Search Expression in the text box where the cursor is displayed (rules 
for creating a valid Search Expression are 

Creating a Valid Search Expression

The Search Expression that you enter in the Expression dialog box drives the database 
search mechanism.    You must enter a valid Search Expression that conforms to Developer 
Source's Search Expression grammar or structure.    The following sections present the 
various structures of (or grammar for creating) valid Search Expressions.

Understanding and Conforming to Search Expression Grammar

To explain Developer Source's Search Expression grammar, we discuss the five major 
components that can comprise a valid Search Expression:    search terms, truncation 
operators, search connectors, search fields, and parentheses.

Understanding Search Terms

The search term is the broadest definition of a Search Expression.    If you execute a Search 
Expression containing only one search term, Developer Source searches for that term in 
every document in the target area.    

For example, if you search for the Search Expression "Windows," Developer Source retrieves 
a list of all documents that contain the search term "Windows."    Search Expressions that 
consist of phrases involve special considerations described in the following sections.

Avoiding Ambiguities in Search Terms

Developer Source automatically evaluates search terms that appear adjacent to each other.  
However, some words that you may want to use in a phrase may be the same words that 
Developer Source recognizes as search operators (see "Using Search Connectors").    If you 
enter these words as part of a Search Expression, Developer Source does not evaluate them 
in the way you intended.    If this is the case, merely enclose the phrase in quotation marks.   
Developer Source then evaluates all words within the quotation marks as part of the Search 
Expression.    



Noting Noise Words

A word that occurs so frequently in the database that it is not useful as a search term is 
called a "noise word".    Included are words such as "and," "of," and "but."    

To increase its efficiency, Developer Source ignores these words when they appear in a 
search term.    For example, if you enter the noise word "of" in the expression 
"Multiprocessing for PCs," Developer Source does not search for "for"; instead, it searches 
for occurrences of "Multiprocessing" two words before "PCs."

Truncating a Search Term

When you want to search for a word that has more than one useful ending (for example, 
walk, walked, walker, walking), enter the first several characters and use the truncation 
operator, which is an asterisk (*), to replace the possible endings.    For example, if you enter
"debug*" as the search term, then Developer Source finds all occurrences of the word 
"debug" as well as "debugged," "debugger," "debugging," and any other variations.    Other 
valid examples using the truncation operator include the following:

process*
limit*
object*

The truncation operator works to find variant endings of a search term only; it cannot appear
at the beginning or the middle of the term or stand on its own to represent a complete word. 
For example, none of the following positions of the truncation operator is valid: *ology, 
Wa*ford, weather *.    However, if the Search Expression consists of several search terms, 
you may use the truncation operator in more than one term.    Valid examples of this type of 
Search Expression include:

comp* netw* 
mem* or window* 

Do not truncate search connectors or field names (described later) and do not surround a 
truncated search term with quotation marks.    

Connecting Search Terms

When you want to search for a combination of Search Expressions, use one of the search 
connectors to tell Developer Source exactly how you want the expressions combined.    
Search connectors fall into two categories: logical connectors and proximity connectors.

Using Logical Search Connectors

Logical search connectors (Boolean operators) include and, or, and and not; they tell 
Developer Source to find documents that contain one Search Expression and another, one 
Search Expression or another, or one Search Expression and not another.

Using and between two search terms tells Developer Source to find documents that contain 
both terms.    The order of the terms in the document does not have to correspond to their 
order in the Search Expression.

Some examples of the and connector are as follows:



windows and memory
debug* and Windows NT
thunk and stack

Using or between two search terms tells Developer Source to find documents that contain 
either or both of the two search terms.

Some examples of the or connector are as follows:

UNIX or DOS
callback functions or callback procedures
network* or LAN

Using and not between two search terms tells Developer Source to find documents that 
contain the first term but not the second.

Some examples of the and not connector are as follows:

server and not database
windows and not NT

When you place more than one search connector in a Search Expression, Developer Source 
reads and evaluates the expression from left to right.    For example, in the expression,

term 1 or term 2 and not term 3 and term 4

term 1 and term 2 are evaluated, then term 3 is subtracted from the result of the first 
operation, and finally term 4 is evaluated with the rest of the expression.    To change the 
order in which an expression is evaluated, see "Using Parentheses to Group Search Terms".

Using Proximity Search Connectors

Proximity connectors include w/n (within/number of words), not w/n (not within/number of 
words), and pre/n (preceding/number of words); they tell Developer Source to find 
documents containing one term separated from another term by the specified number of 
words. 

Using w/n between two search terms tells Developer Source to find documents in which no 
more than n words separate the two terms.    The order of the terms in the document does 
not have to correspond to the order in the Search Expression. 

Some examples of the w/n connector are as follows:

server w/10 Oracle
remote w/2 access
compression* w/10 image*

Using not w/n between two search terms tells Developer Source to find documents in which
at least n words separate the two terms.    The order of the terms in the document does not 
have to correspond to the order in the Search Expression.

Some examples of the not w/n connector are as follows:

compression not w/5 audio
interface not w/10 OLE



Using pre/n between two search terms tells Developer Source to find documents in which 
the first term precedes the second and no more than n words separate them. In this case, 
the order of the terms in the document must correspond to the order in the Search 
Expression.

Some examples of the pre/n connector are as follows:

visual basic pre/5 interface
drag pre/3 drop

Understanding Field Searches

Search fields further subdivide documents.    By specifying a search field, you can limit a 
search to a specified field within the database and bypass irrelevant information.      
Developer Source contains specific fields for magazine and text, journal names, author 
names and, titles of articles.

author
journal
title
text

To enter a field Search Expression, type the field name followed by the Search Expression 
enclosed within parentheses, as in the following example:

title(Windows NT)

In this case, Developer Source searches all entries in the title field for the phrase "Windows 
NT."    

Another valid example is as follows:

journal(IEEE) and title(multimedia)

In this case, Developer Source searches all entries in the journal field for the term "IEEE and 
all entries in the title field for the term "multimedia."    

Note that you can use any search connector as well as the truncation operator in the Search 
Expression (the part within parentheses), but you may not use the truncation operator with 
the field name.

Using Parentheses to Group Search Terms 

You can explicitly group search terms by using parentheses.    For example, the Search 
Expression,

 (Windows 3.1 or Windows NT) and protected mode

finds all documents that contain Windows 3.1 and "protected mode" as well all documents 
that contain the Windows NT and protected mode. 

Taking Advantage of the Search Assist Lists

From the Search Expression dialog box, you can select different Search Assist Lists to aid you



in constructing Search Expressions.    Four Assist Lists are available:

Word List
Operator List 
Previous Search

Selecting the Available Search Assist Lists to Use When Searching

You can select a Search Assist List by choosing the Options command from the Search menu 
or the Options button from the Search Expression dialog box.    The most direct method of 
viewing and selecting a list is to choose the Options command; the Options button is 
available on the Search Expression dialog box for your convenience because this box 
appears often during search procedures.

To select an Assist List using the Options command, 

1.    Select the Search menu.

2.    Choose the Options command. The Search Options dialog box appears containing 
check boxes for selecting assists lists.    The selections you make determine what lists 
you can use when building a Search Expression.    If an Assist List is not available, its 
check box is disabled (grayed).

    
3.    From the section entitled "Assist," select the Assist Lists that you want to have 

available to you when constructing Search Expressions.    

4.    When you have made your selections, choose the OK button. If you want to cancel 
the selections you have made, choose the Cancel button.

To select an Assist List using the Options button,

1.    Choose the Options button from the Search Expression dialog box.    This dialog box 
appears after you have selected the Expression command from the Search menu or 
the New Search command from the    Search Results dialog box or the Search 
Execution Summary dialog box.

After you choose the Options button, the Search Options dialog box appears 
containing check boxes for selecting assists lists.    The selections you make determine
what lists you can use when building a Search Expression.    If an Assist List is not 
available, its check box is disabled (grayed).

2.    From the section entitled "Assist," select the Assist Lists that you want to have 
available to you when constructing Search Expressions.    

3.    When you have made your selections, choose the OK button.

To move the focus between the Assist Lists and the Search Expression dialog box, type ALT 
plus the first letter in the name of the window, or click the window using the mouse.

You can select and place multiple Assist Lists on the screen at one time. Each list remains 
active until you explicitly remove it.

Removing a Search Assist List from the Display

Two methods are available for removing a Search Assist List from the display.    To remove 



an Assist List, 

-    In the Search Options dialog box, click the check box for the    Assist List that you 
want to remove (the check box you selected to display the list), or 

-    Close the Assist List pop-up window using the Control menu (accessed from the 
upper-left corner of the pop-up window).

Using the Word List to Create Search Expressions

The Word List allows you to search through a list of all words contained in the current, select 
words from this list, and place the selected words into the Search Expression text box.    In 
addition, by using the Word List, you can determine if the current domain contains a given 
word, thereby eliminating words that would be unsuccessful as search terms (when not 
contained in the current domain) and selecting words that do appear.

After you choose the Word List command from the Assist menu, Developer Source displays a
pop-up window containing a list of all database words.    

NOTE:    Only those words in the currently selected Search Domain comprise the list.    

To copy a word from the Word List into the Search Expression text box,

1.    Within the Search Expression text box, place the blinking cursor at the location in the
Search Expression where you want the search word to appear.

2.    Move the select bar in the Word List window to the desired search word by using 
standard Windows features (the vertical and horizontal scroll bars) or by entering 
keyboard characters.

3.    Copy the selected word to the Search Expression text box by double-clicking the left 
mouse button, pressing the ENTER key, or choosing the Copy command from the 
Control menu.

You can also remove and replace words in the Search Expression.    To do so,

1.    Mark the text that you want to replace.

2.  Move the select bar in the Word List to the word that you want to place in the Search 
Expression.

3.    Copy the word into the Search Expression by double-clicking the select bar, pressing 
the ENTER key, or choosing the Copy command from the Control menu.    

The selected word replaces the marked text.

Using the Operator List to Create a Search Expression

The Operator List enables you to view a list of all search operators available in the system 
and to enter a selected operator directly from the Operator List window rather than typing it 
in the expression box.    

After you select the Operator List command from the Assist menu, Developer Source 
displays a pop-up window containing a list of the operators available.    Note that the 
proximity search operators have suggested proximity values.    These suggested values are, 



by no means, the only values available.

To copy an operator from the Operator List into the Search Expression text box,

1.    Within the Search Expression text box, place the blinking cursor at the location in the
Search Expression where you want the operator to appear.

2.    Move the select bar in the Operator List window to the desired operator by using 
standard Windows features (the vertical and horizontal scroll bars) or by entering 
keyboard characters.

3.    Copy the selected operator to the Search Expression text box by double-clicking the 
left select bar, pressing the ENTER key, or choosing the Copy command from the 
Control menu.

You can also remove and replace words or operators in the Search Expression 
with new operators.    To do so,

1.    Mark the text that you want to replace.

2.    Move the select bar in the Operator List to the operator that you desire.

3.    Copy that operator into the Search Expression by double-clicking the select bar, 
pressing the ENTER key, or choosing the Copy command from the Control menu.    

The selected operator replaces the marked text.

Using the Previous Search List to Create a Search Expression

The Previous Search List enables you to view a list of all Search Expressions used in previous
searches within the current investigation and to enter a previous Search Expression directly 
from the Previous Search window rather than typing it in the Search Expression text box.    

After you select the Options command from the Search menu, choose the Previous Search 
command, Developer Source displays a pop-up window containing a list of the previous 
Search Expressions available.    If no previous Search Expressions exist, the Previous Search 
command is disabled (grayed).

To copy a previous Search Expression from the Previous Search List into the 
Search Expression text box,

1.  Within the Search Expression text box, place the blinking cursor at the location where
you want the Search Expression to appear.

2.    Move the select bar in the Previous Search window to the desired expression.

3.    Copy the selected expression to the Search Expression text box by double-clicking 
the select bar, pressing the ENTER key, or choosing the Copy command from the 
Control menu.

You can also remove and replace words in the Search Expression.    To do so,

1.  Mark the text that you want to replace.

2.  Move the select bar in the Previous Search window to the desired expression.



3.    Copy the selected expression to the Search Expression text box by double-clicking 
the select bar, pressing the ENTER key, or choosing the Copy command from the 
Control menu. 

The selected previous expression replaces the marked text.

Taking Advantage of the Search Field Lists

Like the Search Assist Lists, the Search Fields Lists can aid you in constructing a Search 
Expression.    From the Search Options dialog box, you can view a list of all Search Fields Lists
(or, simply, "fields") available and pick a field from the list to use in the Search Expression. 
Refer to "Understanding Search Fields" for an explanation of what search fields are, how they
function, and how to place them in Search Expressions.    

This section provides instructions for viewing the lists available and selecting a list, removing
the list from the display, copying a word or phrase from the list into the Search Expression, 
and removing and replacing words in the Search Expression.    Note that, only one Field List 
pop-up window can appear at a time, unlike the Assist Lists feature, which can display 
multiple Assist Lists.    When you choose a new Field List, the new Field List replaces the 
current Field List.

Selecting the Available Field Lists

You can select a Search Field List by choosing the Options command from the Search menu 
or the Options button from the Search Expression dialog box.    Note that you are limited to 
only one Search Field List.    When you select a new Field List, the new Field List replaces the 
current Field List.

The most direct method of viewing and selecting a list is to choose the Options command; 
the Options button is available on the Search Expression dialog box.

To select a Field List using the Options command, 

1.    Select the Search menu.

2.    Choose the Options command. The Search Options dialog box appears    containing a 
drop-down list box for selecting a Field List.    The selection you make determines the 
list that will be available to you as you build Search Expressions.

    
3.    From the drop-down list box in the section entitled "Fields List," select the Field List 

that you want to have available to you when constructing Search Expressions.    

4.    When you have made your selections, choose the OK button.

To select a Field List using the Options button,

1.    Choose the Options button from the Search Expression dialog box.    This dialog box 
appears after you have selected the Expression command from the Search menu or 
the Expression button from the Search Results dialog box or the Search Execution 
Summary dialog box.

After you choose the Options button, the Search Options dialog box appears 
containing a list box for selecting Field Lists.    The selection you make determines the 
list that will be available to you as you build Search Expressions.



    
2.    From the list box in the section entitled "Fields List," select the Field List that you 

want to have available to you when constructing Search Expressions.    

3.    When you have made your selections, choose the OK button.

The active Field List appears in the Field List box. Each list remains active until you explicitly 
remove it.    Later, when you open the Search Expression dialog box, the pop-up window 
containing the specified Field List automatically appears.    If you desire, you can move or 
resize this Field List window.    The window reappears as placed and sized even when you 
remove and then redisplay the Search Expression dialog box.    

To move the focus between the lists and the Search Expression dialog box, type ALT plus the 
first letter in the name of the window, or click the window using the mouse.
 
Removing a Search Field List from the Display

-    In the Search Options dialog box, enter or select a different Field List or "NONE," or
 
-    Close the Field List pop-up window using the Control menu (accessed from the upper-

left corner of the pop-up window).

Copying a Word from a Field List into a Search Expression

1.    Within the Search Expression text box, place the blinking cursor at the location in the
Search Expression where you want the search word to appear.

2.    Move the select bar in the Field List pop-up window to the desired search word by 
using standard Microsoft Windows features (the vertical and horizontal scroll bars) or 
by entering keyboard characters.

3.    Copy the selected word to the Search Expression text box by double-clicking the left 
mouse button, pressing the ENTER key, or choosing the Copy command from the 
Control menu.    Developer Source inserts the selected field at the cursor's location 
within the Search Expression text box.

The selected word or phrase appears in the Search Expression text box surrounded by 
parentheses and preceded by the name associated with the Field List.

Removing and Replacing Words in the Search Expression

You can also remove and replace words in the Search Expression.    To do so,

1.    Mark the text that you want to replace in the Search Expression text box.

2.    Move the select bar in the Field List to the word or phrase that you want to place in 
the Search Expression.

3.    Copy the word or phrase into the Search Expression by double-clicking the word or 
phrase in the Field List, pressing the ENTER key, or choosing the Copy command from 
the Control menu.

The selected word or phrase replaces the marked text surrounded by parentheses and 
preceded by the name associated with the Field List.



Creating a Domain within which to Search

After you create a valid Search Expression, you can also change the Search Domain or target
area for the search.    By specifying the smallest appropriate Search Domain, you focus the 
results of your search, making the results more germane to the area you are researching 
and greatly reducing execution time for most searches.

The default for the current Search Domain is the entire database, or all domain areas.    

To specify a current Search Domain,

1.    Select the Search menu.    

2.    Choose the Expression command.    The Expression dialog box appears containing a 
standard Windows edit control.

3.    Choose the Domain button from the Search Expression dialog box menu bar to 
display the Search Domain dialog box.

The list box within the Search Domain dialog box contains selectable entries.    Within 
an entry, all lines following the first line are indented two characters.

The entries within the Search Domain list box can be subdivided into two categories:    
1) entries that are part of the header (header entries), and 2) entries that are part of 
the current Search Domain level (current-level entries).    A blank line always 
separates the header entries and the current-level entries.

Search Domain entries that are considered header entries appear in a section at the 
top of the Search Domain list box.    These entries serve two purposes:    they identify 
the current location within the Search Domain, and they identify previous (more 
general) levels within the Search Domain.    Domain entries on the current domain 
level appear in a section below the header entries.

4.    Scroll through the Search Domain entries that identify various levels of Search 
Domains or target areas within the database.    The selection bar highlights individual 
entries as you scroll.

At the beginning (or left-most edge) of all domain entries a symbol identifies the 
default action that takes place when, as described in the next step (Step 5), you 
highlight an entry and choose the Change Levels button.    The symbols and the 
actions that occur when you select entries marked by these symbols are as follows:

plus (+)    
Developer Source moves to another level of Search Domains.    If the selected 
entry is a header entry, Developer Source moves to a previous level (a more 
general level or a listing above the current entry).    If the selected entry is a 
current level entry, Developer Source moves to a next level (a subset of or 
listing beneath the current entry).

minus (-)    
Developer Source disables (grays) the Change Level button when you 
highlight an entry preceded by a minus symbol because no subheadings exist 
beneath this level of heading. 



The unmarked entry indicates your current location.    If you select this entry, you 
remain at the current location within the database hierarchy of possible Search 
Domains.    

5.    To move to a new level within the database, highlight the entry (the level) and 
choose the Change Level button.    As you move to new levels within the database, 
you enlarge or narrow possible Search Domains.    Note that if a currently highlighted 
Search Domain entry is preceded by a bottom-most or lowest-level symbol (-), the 
Change Level button is disabled (grayed).

6.  Each time that you locate a Search Domain that you want for your search, choose the
Select button or double-click to select that domain area for your Search Domain.    

You can designate more than one area of the database for a search by selecting 
various Search Domain entries.    When an entry is selected or contains a more 
specific, lower-level entry that has been selected, the words "complete" or "partial" 
appear at the right of the entry.

NOTE:    If you want to remove a selected domain area from the search environment 
that you are constructing, move the select bar to the domain entry.    Choose 
the Unselect button (a toggle button functioning as a Select button for entries 
that are not selected, and as an Unselect button for entries that have been 
selected).

To unselect all entries in the Search Domain, choose the Clear button.

7.    Choose the OK button.    Developer Source changes the Search Domain to the new 
domain that you have specified and returns you to the Search Expression dialog box.   
The new Search Domain is indicated within the Search Domain dialog box.    If you 
have not selected a domain, the OK button is disabled (grayed).

.
Executing the Search

After you have created a Search Expression, you are ready to execute the search.    

1.    Select the Search menu.    

2.    Choose the Expression command.    The Expression dialog box appears.

3.  If you have not already done so, enter a Search Expression and specify a Search 
Domain.

4.  Choose the Execute button within the Search Expression dialog box to begin the 
process of searching the identified areas of the database for the Search Expression.    

Evaluating the Search Results 

If all validity checks are successful, the Search Execution Summary dialog box appears 
summarizing the steps of the evaluation process as they occur.    After the search is 
complete, you can scroll the text box displaying the steps of the search evaluation.    

If you determine that the results are valuable and that you want to explore them further, you
should register the results, as discussed below.    If you decide that the search was 
insignificant, you can eliminate all traces of the search.    



The sections that follow direct you in registering, canceling and, finally, viewing and 
exploring the results of the search.

Registering Search Results (the OK Button and the Expression Button)

If you want to register the search results (enabling you to manipulate the results and move 
to the database text locations pinpointed by the search), you can choose either the Results 
button or the New Search button.    When you choose the Results button, Developer Source 
registers the search results and removes the Search Execution Summary dialog box; when 
you choose the New Search button, Developer Source registers the search results and 
displays the Search Expression dialog box again.    When you choose either of these buttons, 
Developer Source also registers the Search Expression in the list of previous Search 
Expressions available through the Assist menu in the Search Expression dialog box.

Canceling the Search Evaluation (the Close Button)

You can terminate the search evaluation process at any time by clicking the Cancel button.    
Choosing the Cancel button does not register the new "Active Search Environment."    The 
current "Active Search Environment" remains as it is.    In addition, the current Search 
Expression is not added to the list of previous Search Expressions available through the 
Assist menu in the Search Expression dialog box.

Viewing and Exploring the Results of the Search Evaluation (the Results Button)

You can choose to see the results of the search evaluation by choosing the Results button.    
If the search evaluation is still in progress, this button is disabled (grayed).

For a detailed account of how to view and manipulate the results of the search evaluation, 
see "Viewing and Exploring the Results of a Search (the Results Command)."



Direct Searching (the Direct Command)
Direct Searching enables you to search directly without having to choose the Expression 
command and type in the Search Expression.    For example, if you are browsing through text
and see a word or group of words you would like to search for, such as "AVI driver," you can 
select the text and automatically insert it into the Search Expression text box rather than 
having to choose the Expression command within the Search menu and type the text "AVI 
driver."

To perform a direct search,

1.    Using standard Windows marking techniques, mark the database text that you want 
to find.

2.    Select the Search menu.    

3.    Choose the Direct command.    The Search Expression dialog box appears with the 
marked text surrounded by quotation marks and placed in the Search Expression text 
box.    Note that the marked text appears in reverse video within the Search 
Expression text box.    

At this point, you can remove the text, modify it, add to the Search Expression, and so forth, 
proceeding as you normally do in creating a search with the Expression command.



Paste Searching (the Paste Search Command)
"Paste" searching is very similar to Direct searching, except that the Search Expression is 
copied to the Windows Clipboard from some other software program.    Then you enter 
Developer Source, select the Paste Search command from the Search menu.    The Search 
Expression will be automatically pasted from the Clipboard into the Search Expression box.



Viewing and Exploring the Results of a Search (the Results 
Command)

After you have executed the search, the Results command enables you to view the results in
various ways according to your needs.    For example, not only can you display documents 
containing occurrences of the Search Expression, you can instruct Developer Source to 
display documents in a particular order--starting either with the document containing the 
greatest number of search terms or with the document occurring first in the database.    In 
other words, Developer Source can list and consequently display documents containing 
search terms from the first document to the last document within the database or from the 
greatest number of occurrences to the fewest number.

Displaying Occurrences of the Search Word

1.    Select the Search menu.

2.    Choose the Results command or the Results button within the Search Evaluation 
dialog box.    The Search Results dialog box appears listing all documents that contain 
occurrences of the Search Expression as well as other information pertinent to the 
search, discussed in the next section, "Understanding the Search Results Dialog Box."

3.  After scrolling the list of documents, you will undoubtedly want to open the 
documents containing the Search Expression occurs.    To display the text of a 
particular document containing the Search Expression, select the document from the 
list and choose the "Go To Text" button.    Developer Source displays either the top of 
the document or the first search word in the document, depending on the current 
setting within the Search Options dialog box (see "Setting Search Options").

Understanding the Search Results Dialog Box 

The Search Results dialog box provides a list of documents containing the Search 
Expression, as well as information pertaining to the search results.    Within the Search 
Results box, each entry contains the publication name, issue date and, title of the article.

At the top of the dialog box, Developer Source provides information about the document 
designated by the currently selected entry (the entry highlighted by the select bar) and 
about the entries as a whole.    The first two items listed pertain to the current entry--the first
being the document number within the total number of documents (for example, "Document
5 of 200"), and the second, the number of "keyword hits" or number of words highlighted 
within the document.    

Three buttons appear at the bottom of the dialog box:    the Go to Text button, the Close 
button, and the New Search button.    When you choose the Go to Text button, Developer 
Source displays the text of the document selected in the list box.    When you choose the 
Close button, Developer Source cancels the results of the search and removes all dialog 
boxes from the screen; when you choose the New Search button, Developer Source cancels 
the results of the search and displays the Search Expression dialog box.



Setting Search Options (the Options Command)
Developer Source's Options command allows you to control the display and order of the 
search documents, default operator, Search Domains, Assist Lists, and Field List. The Search 
Options dialog box enables you to control whether Developer Source displays a retrieved 
document at the top of the document or at the location of the first keyword in the document.
You can also determine how the search results are ordered--by location in the database (first 
to last) or by the number of keyword occurrences (greatest to smallest), and you can 
designate which search operator Developer Source uses, by default, when you copy 
information from the various Assist Lists within the Search Expression dialog box.    In the 
"Domain" section, you can specify whether the next search should examine the current 
domain that you already specified in the Domain dialog box or examine only the results of 
the previous search as a domain.    Finally, you can choose the Assist Lists and the Field List 
to have available as pop-up windows when building Search Expressions. 

To designate how Developer Source displays and orders the search results,

1.    Select the Search menu.

2.    Choose the Options command.    The Search Options dialog box appears.

3.    If you want to change how Developer Source displays the documents, examine the 
"Document Position" box and choose the option button indicating the display that you 
prefer.  Two display options are available: displaying the first search keyword of the 
document or displaying the top of the document.

4.    If you want to change how Developer Source orders the documents, examine the 
"Order Search Results By" box and choose the option button that indicates the order 
you prefer.    Two options are available:

-    ordering documents by number of keyword occurrences (the first 
document in the Search Results List contains the greatest number of search 
words, the second document contains the second greatest number of search 
words, and so on)

-    ordering documents by location in the database (the first document in the 
Search Results List occurs first in the database text, the second document occurs 
second in the database, and so on)

5.  Choose the OK button.    Developer Source records the new search options and 
returns you to the database text.    If you change the search option "Order Search 
Results By" from "Location in Database" to "Number of Occurrences," a slight delay 
occurs as the system re-orders the current search results to reflect the new search 
option.

To designate which default search operator Developer Source uses when copying 
information from the Assist List into the Search Expression dialog box,

1.  Select the Search menu.

2.  Choose the Options command.    The Search Options dialog box appears.

3.    From the "Default Search Operator" section of the Search Options dialog box, choose 
the option button that indicates the default search operator that you prefer.    Three 
options are available:



AND operator 
OR operator
NONE      

If you choose NONE, a search operator is not is inserted in the Search Expression as 
you copy search terms into the Search Expression dialog box.

4.  Choose the OK button.    Developer Source records the new search options and 
returns you to the database text.

To designate the Search Domain that Developer Source is to use for the next 
search, 

1.    Select the Search menu.

2.    Choose the Options command.    The Search Options dialog box appears.

3.    Examine the "Domain" box and choose the option button indicating the domain that 
you prefer.  Two domain options are available: 

-    the current domain (the default), which uses the domain that you specified in 
the Domain dialog box (the Domain dialog box appears in response to the Domain
command or the Domain button in the Search Expression dialog box)

-    the previous search, which uses the previous search results as the domain 
(Developer Source actually creates a Search Expression consisting of the current 
Search Expression, the AND operator, and the previous Search Expression)

4.  Choose the OK button.    Developer Source records the new Search Domain and 
returns you to the database text.    

To designate which Assist Lists are displayed when using the Search Expression 
dialog box,

1.    Select the Search menu.

2.    Choose the Options command. The Search Options dialog box appears containing 
check boxes for selecting assists lists.    The selections you make determine what lists 
you can use when building a Search Expression.    If an Assist List is not available, its 
check box is disabled (grayed).

    
3.    From the section entitled "Assist," select the Assist Lists that you want to have 

available to you when constructing Search Expressions.    

4.    When you have made your selections, choose the OK button. If you want to cancel 
the selections you have made, choose the Cancel button.

To designate which Field List is displayed when using the Search Expression 
dialog box,

1.    Select the Search menu.

2.  Choose the Options command. The Search Options dialog box appears containing a 
drop-down list box for selecting a Field Word List.    The selection you make determines



the Field Word List that will be available to you as you build Search Expressions.
    
3.    From the drop-down list box in the section entitled "Field Word List," select the Field 

Word List that you want to have available to you when constructing Search 
Expressions.    

4.    When you have made your selections, choose the OK button. If you want to cancel 
the selections you have made, choose the Cancel button.



Moving to the Next Keyword (the Next Keyword Command)

The Next Keyword command enables you to move directly to the next occurrence of the 
search word (keyword) within the current document that Developer Source located during 
the current search.    

To display the next keyword within the current document, 

1.  Select the Search menu.

2.  Choose the Next Keyword command.    

If you are displaying the last search word within the present document, choosing this 
command causes the first search word of the next document to be displayed.    

If you have reached the last search word in the database, the Next Keyword command is 
disabled (grayed).



Moving to the Next Document (the Next Document Command)

The Next Document command enables you to move directly to the next document 
containing the search word.    Note that either the top of the document or the first search 
word in the document is displayed, depending on the current setting within the Search 
Options dialog box discussed previously.    

To display the next document containing the search word, 

1.    Select the Search menu.

2.    Choose the Next Document command.    

If you are displaying the last search document in the database, this command is disabled 
(grayed).    



Moving to the Previous Document (the Previous Document 
Command)

The Previous Document command enables you to move directly to the previous document 
containing a search word.    Note that either the top of the document or the first search word 
in the document is displayed, depending on the current option set within the Search Options 
dialog box discussed previously.

To display the previous document containing the search word,    

1.    Select the Search menu.

2.  Choose the Previous Document command.    

If you are currently displaying the first search document in the database, this command is 
disabled (grayed).

 



Introduction to the ASSISTS Menu
The Assists menu offers aids to locating and extracting information.    You can make and save
Bookmarks and annotations (notes), select settings to identify search keywords, 
annotations, and cross-references

You also have miscellaneous tools for enhancing images, magnifying images, and defining
how the mouse interacts with images.



Creating and Editing an Annotation (the Edit/View Command)

Developer Source's Edit Annotation command enables you to create, edit, manipulate, save, 
rename, and exit annotations.    Annotations, as implemented within the Developer Source 
product, are analogous to stick-on notes that you might place in a printed product or to 
writing in the margins of the book.    Annotations fall into two categories or types:    public 
and private.    

Public annotations are stick-on notes that are stored on the computer system associated 
with the current database.    All database users on the system can view these annotations, 
but only those users with "system privileges" can modify any aspect of these annotations.

Private annotations are stick-on notes that any user can attach to database text.    After you 
establish an annotation, you can copy database text into it, enter you own comments, or 
combine these two activities.

Private annotations are contained within specific investigations--when you are working 
within one investigation, you cannot see annotations from other investigations.    When you 
save an investigation, the annotations for that investigation are saved with it.    They are 
restored along with other components of the investigation.    

Creating a New Annotation

1.    Using standard Windows capabilities, mark the database text that you want to 
annotate.

2.    Select the Assists menu.

3.    Choose the Edit Annotation command.    If you have system privileges, a dialog 
box appears prompting you to determine if this annotation is to be a public or 
private annotation.    

4.    To specify a public annotation, select the Public Annotation option button.    
Likewise, to specify a private annotation, select the Private Annotation option 
button.    Choose the OK button to begin the process of creating the new 
annotation.    

The Annotation Editor window appears containing a caption and menu bar.    This window 
contains a cursor for entering text, and is ready to receive database text copied from the
Clipboard (see "Pasting Text from the Clipboard to the Annotation Editor Window:    the 
Paste Command").    This window also contains a Save button, a Cancel button, and an 
Annotation Title text box.    

When the text you create within the Annotation Editor window exceeds the window's 
width, Developer Source breaks the text at a word boundary and wraps it to the next 
line.

The Annotation Editor window does not vary in size and location from annotation to 
annotation and from investigation to investigation within a single session.    In other 
words, any change in size or location of the window affects the window for all 
annotations within all investigations until you end the current session and begin a new 
one.    The window size and location remain the same until you explicitly change them.



Note that database text associated with or marked for one type of annotation (private or 
public) cannot overlap database text associated with another annotation of the same 
kind (private or public).    In addition, the annotation text created (text that appears 
within the annotation box or window) cannot be searched.

The Annotation Editor contains features that perform various functions.    These features--
the Control-menu box, Annotation Title text box, the Save button, the Cancel button, and 
the Edit menu--are discussed in the sections that follow.

Saving an Annotation Under its Current Name

Click the Save button.    If the annotation does not have a name, Developer Source 
prompts you for one. 

Storing an Annotation Under a New Name

Enter the annotation name in the Annotation Title text box.    Developer Source allows up 
to 32 characters for an annotation name.    

Developer Source prevents you from creating multiple annotations with the same name.  
If you enter a duplicate name, Developer Source prompts you to change the name or 
allow it to create a unique name.

Exiting an Annotation

To exit the Annotation Editor and return to the current location in the 
database, choose the Cancel button.

Before exiting, the Annotation Editor prompts you to save the contents of the current 
annotation, if you have not already done so.    To save the annotation before you exit, 
respond by choosing the Yes button.    If you do not want to save the annotation, choose 
the No button.    If you want to cancel the exiting process and return to the Annotation 
Editor, choose the Cancel button.

Using the Edit Menu to Edit an Annotation

An Edit menu, available from the menu bar of the Annotation Editor window, enables you
to:
-    cut text from the Annotation Editor window to the Clipboard
-    copy text from the Annotation Editor window to the Clipboard
-    paste text from the Clipboard into the Annotation Editor window
-    clear (delete) text from the Annotation Editor window

Moving Test from the Annotation Editor Windows to the Clipboard (the Cut 
Command)

The Cut command copies marked text from the Annotation Editor window to the Clipboard 
and deletes it from the Annotation Editor window.    To use this command,

1.  Using standard Windows capabilities, mark the annotation text that you want to cut 
to the Clipboard.

2.    Select the Edit menu.



3.  Choose the Cut command.

Copying Text from the Annotation Editor Window to the Clipboard (the Copy 
Command)

The Copy command copies marked text from the Annotation Editor window to the Clipboard. 
The marked text is NOT deleted from the Annotation Editor window.    To use this 
command, 

1.    Using standard Windows capabilities, mark the annotation text that you want to copy
to the Clipboard.

2.    Select the Edit menu.

3.  Select the Copy command.

Pasting Text from the Clipboard to the Annotation Editor Window (the Paste 
Command)

The Paste command copies text from the Clipboard to the Annotation Editor window at the 
current location--the location of the blinking cursor.    To use this command,

1.    Move the blinking cursor to the location in the Annotation Editor window where you 
want the text to be inserted.

2.    Select the Edit menu.

3.    Choose the Paste command.

Deleting Text from the Annotation Editor Window (the Clear Command)

The Clear command deletes marked text from the Annotation Editor window.    The marked 
text is NOT copied into the Clipboard.    

To delete text from the Annotation Editor window,

1.    Using standard Windows capabilities, mark the annotation text that you want to 
delete from the Clipboard.

2.    Select the Edit menu.

3.    Choose the Clear command.

Editing an Existing Annotation

Editing an existing annotation is identical to editing a new annotation, except that you begin
with the following two steps:

1.    Move the system blinking cursor to an annotation within the database text.

NOTE:    You can identify annotations by an attribute set with the Change Display 
command under the Assists menu.    That attribute must be specified and in 
effect for you to locate annotations.

2.    Perform one of the following two actions:



-    Double-click the left mouse button on the annotated text.

-    With the blinking cursor located on annotated text, choose the Edit Annotation 
command under the Assists menu.

The Annotation Editor Window appears containing the name of the annotation in its title text
box.    You can now edit the annotation following procedures discussed earlier (see the 
section entitled "Using the Edit Menu to Edit a New Annotation").    Note that you can edit 
public annotations only if you have "system privileges."      



Returning to an Existing Annotation (the Return to Annotation 
Command)
After you have created one or more annotations and have moved on to other activities, you 
can easily return to any annotation by using the Return to Annotation command.    Developer
Source keeps a list of the annotations you establish so that you can review the list as a 
whole and select the annotation that you want to see along with the associated database 
text.    In addition, the Return To command allows you to change from public to private 
annotations and vice versa and to delete annotations.

Returning to an Annotation

To return to an existing annotation within the current investigation,

1.    Select the Assists menu.

2.  Choose the Return to Annotation command.    The Return to Annotations dialog box 
appears listing all public or private annotation names (public or private as you 
indicated in the Edit Annotation dialog box or the Return To Annotations dialog box).    
These entries are arranged alphabetically in the Annotation Title list box.    An 
Annotation Text dialog box contains the text of the annotation.    

3.    Move the selection cursor to the name of the annotation that you want to see.

4.    Choose the OK button to remove the Return to Annotations dialog box and open the 
database at the text location associated with the annotation you have selected.    If 
you have not selected an annotation, this button is disabled (grayed).

When you open the database at the specified Annotation, the Annotation Editor Window 
appears displaying the contents of the selected annotation.

NOTE:    If your version of Developer Source indicates--by methods such as bolding or 
italicizing--which words are annotated, you can also return to an annotation by 
placing the cursor on the annotated text and double-clicking the left mouse 
button.

Changing Between Public and Private Annotations

The Return to Annotation command also enables you to switch from a list of Public 
Annotations to a list of Private Annotations and vice versa when you are selecting 
annotations from the Return to Annotations dialog box.    

To change the list of annotations from Private Annotations to Public Annotations 
or vice versa, 

1.    Select the Assists menu.

2.  Choose the Return to Annotation command.    The Return to Annotations dialog box 
appears listing all public or private annotation names (public or private as you 
indicated with the Edit Annotation dialog box or the Return to Annotations dialog box). 
These entries are arranged alphabetically in the Annotation Title list box.    An 
Annotation Text dialog box contains the text of the annotation.    

3.    From the Return to Annotations dialog box, select the option button indicating the 



type of annotation that you want to see (either public or private).    Public annotations 
are the default type.    The list of annotation names are immediately updated to reflect
the newly selected type of annotation.

Deleting an Annotation

The Return To command also enables you to delete annotations, although you must have 
system privileges to delete a public annotation.    

To delete an annotation from the list of annotations,

1.    Select the Assists menu.

2.    Choose the Return to Annotation command.    The Return to Annotations dialog box 
appears listing all public or private annotation names (public or private as you 
indicated in the Edit Annotation dialog box or the Return to Annotations dialog box) 
within the current investigation.

3.    Move the selection cursor to the name of the Annotation that you want to delete.

4.    Choose the Delete button to delete or remove the currently selected Annotation from
the list of Annotations.    If you have not selected an Annotation, this button is disabled
(grayed).



Re-linking Annotations after an Update ( the Link Annotation 
Command)
The Link Annotation command enables you to re-link annotations that have become unlinked
from database text.    Annotations are automatically unlinked when the database is updated, 
which results in modifying or removing the database text to which an annotation is linked.

Annotations are unlinked at one of two different levels--page level or database level--as 
explained below: 

Page Level
An annotation unlinked at the page level is still roughly associated with the page of 
text to which it was previously linked, but it is no longer tied to any specific text on 
that page.    Unlinking at the page level usually occurs when the text to which the 
annotation is attached is modified or deleted, but the page as a whole remains intact.

Database Level
An annotation unlinked at the database level is associated with the database as a 
whole, but is not tied to any specific text within database.    Unlinking at the database
level usually occurs when the logical group of pages containing the text to which the 
annotation was attached is deleted.

To re-link an Annotation,

1.    Using standard Windows capabilities, mark the database text to which you want to 
attach an annotation.

2.    Select the Assists menu.

3.    Choose the Link Annotation command.    A dialog box appears from which you can 
choose the annotation to link to the text you marked in step one above.

4.    Specify the type of Annotation to link by selecting either the private or public option   
button in the Annotation type section.    

5.    Move the selection cursor within the list of Annotation titles to choose which 
Annotation to link to the marked text.    Note that, as you move the selection cursor, 
the annotation text associated with the annotation title appears in the window on the 
right side of the dialog box.

6.    Select the Link button to link the selected Annotation to the marked database text.

NOTE:    If the text has been unlinked at the page level, and you want to re-link it to the 
same page (the page to which it was previously linked), choose the OK button.    Developer 
Source displays the page to which the text had been linked.    Note that the OK button is 
enabled only if the annotation is unlinked on the page level and no text is currently 
marked.



Placing a Bookmark in the Database Text (the Place Bookmark 
Command)

Developer Source's Place Bookmark command allows you to place electronic Bookmarks at 
various places in the database so that you can return to those locations later.    

To place a Bookmark in the text of your database, 

1.    Put the blinking cursor at the text location where you would like to establish a 
Bookmark.

2.    Select the Assists menu.

3.  Choose the Place Bookmark command.    The Place Bookmark dialog box appears.

4.    In the text box, enter a name for the Bookmark.    

If the Bookmark name you entered is already being used, Developer Source prompts 
you to overwrite the Bookmark name or to enter a different Bookmark name.    Choose
the OK button to overwrite the existing Bookmark, or press the No button to return to 
the Place Bookmark dialog box to try another Bookmark name. 

5.    Choose the OK button in the Place Bookmark dialog box or press the ENTER key.

To abort this procedure, select the Cancel button or press the ESCAPE key.



Returning to a Bookmark (the Return to Bookmark Command)
After you have placed Bookmarks in the database text, you can use the Return to Bookmark 
command to quickly view a list of these Bookmarks and return to the text locations they 
identify.    

To return to a Bookmark that you have placed in the database text, 

1.    Select the Assists menu.

2.    Choose the Return to Bookmark command.    A dialog box appears displaying a list of 
the available Bookmarks in the Bookmarks list box.    Each entry represents a 
Bookmark placed within the text of the database.

3.  Traverse the list of Bookmarks by using standard Windows features (the vertical and 
horizontal scroll bars) or by entering keyboard characters.

4.    Select the Bookmark that you want to return to.

5.    Choose the Go to Text button or press ENTER to open the database at the Bookmark 
location in the text.    If you have not selected a Bookmark, the Go to Text button is 
disabled (grayed).    

Deleting a Bookmark with the Delete Button

The Return to Bookmark command also enables you to delete an existing Bookmark.    To 
delete a Bookmark, 

1.    Select the Assists menu.

2.    Choose the Return to Bookmark command.

3.    Select from the list of Bookmarks the Bookmark that you want to delete.

4.    Choose the Delete button.    If you have not selected a Bookmark, this button is 
disabled (grayed).



Indicating Display Preferences (the Change Display Command)
Developer Source's Change Display command enables you control how Developer Source 
displays special items within the database.    When you choose the Change Display 
command, a submenu appears listing the Item Attributes command.

The Item Attributes command enables you to change the font style as well as the 
background and foreground colors of particular database items (such as search keywords, 
annotations and cross-references) that you want to distinguish from surrounding text.

NOTE:  
-    Changes that you make in the Item Attributes dialog box (discussed next) 

occur across all sessions and investigations.    Any changes that you make in 
style attributes, background colors, or foreground colors for the current 
investigation will be in effect for subsequent investigations as well, until you 
explicitly change them again by using the Item Attributes dialog box.

-    The version of the Developer Source database that you are using does not 
offer options for Page Attributes.    Since the Page Attribute options does not 
exist for this version, the Change Display command invokes the Item Attributes 
dialog box, rather than a submenu listing the Item Attributes and Page 
Attributes commands.



Changing Item Attributes (the Item Attributes Command)
The Item Attributes command enables you to change the style attributes as well as the 
background and foreground colors of particular database items (such as search keywords, 
annotations and cross-references) that you want to distinguish from surrounding text.    To 
visually identify these items, you can designate background and foreground colors for the 
item or style attributes of bold, italic, underline, and "strikeout."

Selecting Style Attributes

To change the style attributes of a search keyword, annotation, cross-
reference, or other special item,

1.    Select the Assists menu.

2.    Choose the Change Display command.    A sub-menu appears listing the Item 
Attributes commands.

    
3.    Select the Item Attributes command.    The Item Attributes dialog box appears 

with a Selected Item drop-down list box, drop-down list boxes for background and 
foreground colors, check boxes for applying style attributes, and the Item Example
box that displays the current appearance of the selected item.

4.    From the Selected Item drop-down list box, select the item you want to change.    
Developer Source displays the current appearance of this item in the Item 
Example box.    The sample in the Item Example box reflects the changes that you 
make to the item as these changes occur.

5.  From the Style check boxes, select or turn on the style attributes (bold, italic, 
underline or strikeout) that you want to apply to the selected item and turn off any
attributes that you no longer want to apply to the selected item.

6.    If it is not already turned on, turn on the Enable Item Attribute check box.    The 
appearance of the item in the Item Example box changes reflecting the new 
attribute that you specified. 

7.    Choose the OK button to execute these changes.    Developer Source removes the
dialog box and displays the database items marked with the new attribute(s) that 
you selected.    

Selecting Background or Foreground Colors

For background and foreground colors, you can use the default colors provided, or you 
can choose colors from the lists of colors available.      

To use default colors for background and foreground colors to distinguish a 
particular item from surrounding portions of the database (text or graphics),

1.    Select the Assists menu.

2.    Choose the Change Display command.    A sub-menu appears listing the Item 
Attributes.

    
3.    Select the Item Attributes command.    The Item Attributes dialog box appears 

with a Selected Item drop-down list box, drop-down list boxes for background and 



foreground colors, check boxes for applying style attributes, and the Item Example
box that displays the current appearance of the selected item.

4.    From the Selected Item drop-down list box, select the item you want to change.    
Developer Source displays the current appearance of this item in the Item 
Example box.    The sample in the Item Example box reflects the changes that you 
make to the item as these changes occur.

5.    Select or turn on the Use Default Colors check box.    

6.    If it is not already turned on, turn on the Enable Item Attributes check box.    
Developer Source displays the new appearance of this item in the Item Example 
box.    

7.  Choose the OK button to execute these changes.    Developer Source removes the 
dialog box and displays the database item with the default colors.    

To specify a background color or foreground color or both to distinguish a 
particular item from surrounding portions of the database (text or graphics),

1.    Select the Assists menu.

2.    Choose the Change Display command.    A sub-menu appears listing the Item 
Attributes commands.

    
3.    Select the Item Attributes command.    The Item Attributes dialog box appears 

with a Selected Item drop-down list box, drop-down list boxes for background and 
foreground colors, check boxes for applying style attributes, and the Item Example
box that displays the current appearance of the selected item.

4.    From the Selected Item drop-down list box, select the item you want to change.    
Developer Source displays the current appearance of this item in the Item 
Example box.    The sample in the Item Example box reflects the changes that you 
make to the item as these changes occur.

5.  Select the Background or Foreground drop-down list box to display the list of 
available colors.    Foreground colors color the letters or figure while background 
colors color the screen behind the letters.    A selection cursor consisting of a white
and black frame highlights the color that currently distinguishes the selected item.

6.    Select the color that you prefer from the list of colors available.    

7.    If it is not already turned on, turn on the Enable Item Attributes check box.

8.  Choose the OK button to execute these changes.    Developer Source removes the 
dialog box and displays the database with the item    colored as you specified.    



Invert Image & Enhance Image Commands (images only)
These two commands are only available when viewing an image.    

Invert Image merely applies "reverse video" to the image.    Some images are slightly more 
legible when shown in reverse video.

Enhance Image applies a "dithering algorithm" to an image, shading in lines to make them 
more clear.    You will find that some images benefit substantially with enhancement, while 
others do not.



Mouse Actions Command (images only)

This command is only available when viewing an image.    It allows you to select three 
different functions for one of the mouse buttons:

1.    Auto Zoom:    when the mouse button is clicked and dragged, you draw a "ghost box" on 
the image.    When you release the mouse button, the image area you "ghosted" is enlarged 
to fill the image window.    Notice that you can enlarge with this feature, but you cannot 
reduce the image with this feature.

2.    Magnifying Glass:    when the mouse button is clicked and dragged, you "launch" a small 
image window that displays a magnified portion of the image.

3.    Pan:    when the mouse button is clicked and dragged, a "hand icon" acts just like you put
your hand on a sheet of paper, allowing you to slide the image around within the viewing 
window.



Magnify Options Command (images only)

This command opens a dialog box, in which you can adjust the magnification intensity of the
magnifying glass.    This adjustment is only noticeable when you select the Magnifying Glass 
option in the Mouse Action menu.



Set Magnify Area (images only)

This command allows you to position and size the magnification window anywhere you want 
(within the image window).

To use the command, you must first "mark" a section of the image.    Place the cursor in the 
upper left-hand corner of where you want the magnification window to be located, click the 
left mouse button, drag a dark shadow-box to the size you want the magnification window to
be, then release the mouse-button.    Now select Assists Menu / Set Magnify Area.    After 
making this selection, it will seem like nothing happened, except the menu disappeared and 
the shadow-box disappeared.    Next, Select Assists Menu / Mouse Action Command / 
Magnifying Glass.    Now put the cursor on the image (notice the magnifying glass icon), click
and drag the right mouse button.    Now you will see the magnification window in just the 
place and just the size that you set it.
 



Introduction to the Zoom Command (and other techniques)
"Zooming" an image affects the magnification of the image.      There are several techniques 
of zooming.    Zoom menu commands affect magnification from the center of the image 
window.    They allow you to zoom in and out by preset amounts of magnification, to set the 
amount of magnification you want, and to instantly re-size the image to fit the window.

There are several zooming techniques which are NOT found in the Zoom Menu.    Three of 
these are:

1.    Autozoom, found under Assists Menu / Change Display Command / Mouse Actions, allows
you to use the mouse to zoom (using a "ghost box")

2.    Magnifying Glass, also found under Assists Menu / Change Display Command / Mouse 
Actions, allows you to use the cursor like a magnifying glass.

3.    Use the Plus (+) and minus (-) keys on the keyboard to zoom in and out.



Increasing Magnification (the In x% Command)
The In x% command magnifies or zooms in on an image (toward the image center) by the 
percent indicated in the Zoom menu.    

To zoom in on an image,    

1.    Select the Zoom menu.

2.  Choose the In x% command.    Developer Source zooms in on the center of the image. 

To reverse the effect, use the Out x% command.



Decreasing Magnification (the Out x% Command)
If you choose the Out x% command, the magnification of the image is decreased by the 
percent indicated in the Zoom menu.    

To zoom away from an image,    

1.    Select the Zoom menu.

2.    Choose the Out x% command.    Developer Source zooms away from the center of 
the image.    

To reverse the effect, use the In x% command.



Zooming in on a Portion of the Image (the Zoom Rectangle 
Command)
The Zoom Rectangle command allows you to mark a rectangular area of the image, and 
then to zoom in on that marked area.    

To zoom in on the marked area using the Zoom Rectangle command,

1.    Mark the area you wish to Zoom by following these steps:

(i.)    Press the left mouse button.    

(ii.)    Drag the pointer across the image to mark the area you want to copy.    The 
marked portion appears in inverted colors on the screen.    

(iii.)    When you have marked the area that you want to Zoom, release the mouse 
button.    If you are not satisfied with the area you have marked, repeat these 
steps (the first area will be cleared).

2.    Select the Zoom menu.

3.    Choose the Zoom Rectangle command.    

The marked area of the image fills the image window.    Zooming in on an image does not 
affect inversion mode.

NOTE:    You can also Zoom in on an image by dragging a box across the image rather than 
by using the Zoom Rectangle command.    To zoom the image in this way, 

1. Select the Mouse Action command from the Assist Menu.

2. Choose the Auto Zoom command.

3. Press and hold the right mouse button.

4. While continuing to press and hold the right mouse button, move the mouse to create 
a box over the portion of the image that you want to zoom in on.

5. When the box covers the portion that you want to zoom in on, release the mouse 
button.    

The portion of the image in the box immediately fills the screen.



Changing the Zoom Percentages (the Set Zoom Command)
The Set Zoom command enables you to change the percentage shown in the In x% and Out 
x% commands, thereby increasing or decreasing the percentage by which these commands 
zoom in on or away from images.    

To change the zoom percentages,

1.    Select the Zoom menu.

2.    Choose the Set Zoom command.    The Set Zoom dialog box appears.    

3.    Use the mouse and scroll bar or the keyboard and text box to select a new 
percentage.

4.    Press OK.    

The new zoom percent remains in effect until you change it, begin another investigation, or 
end the session.



Resetting Image Display (the Reset Image Command)
When you first display an image, Developer Source scales it so that its most narrow 
dimension completely fills the window.    As a result, some of the image is offscreen.    After 
subsequent zooming alters the display, the Reset Image command can restore the original 
display.    

To restore the original image display,

1.    Select the Zoom menu.

2.    Choose the Reset Image command.

Resetting an image does not affect inversion mode.



Displaying the Entire Image (the Full Image Command)
The Full Image command allows you to view the entire image in the image window.

To view the entire image, 

1.    Select the Zoom menu.

2.    Choose the Full Image command.    

The display adjusts so that the entire image is visible.

 



Rotate Left, Right, & Home Commands (for images only)
The Rotate Left and Rotate Right commands operate at 90-degree increments.    
The Rotate Home command always returns the image to its original orientation.



Mirror Image Command (for images only)
The Mirror Image command reverses the image as if it were reflected in a mirror.    This 
command works regardless of magnification of rotation of the image.    

 



Using the Window Menu Commands
Developer Source's Window menu contains commands that enable you to automatically 
display open windows at the same time without having to size and move them.    Moreover, 
you can choose commands that automatically change the arrangement of these windows to 
a cascade layout, a tiled display, or a default display.



Tiling Windows (the Tile Command)
The Tile command positions open windows so that they are above, below, and next to each 
other, and fully occupy the current size of the Developer Source window.    The active window
appears in the upper left of the screen.

To tile all open windows, 

1.    Select the Window menu.

2.    Choose the Tile command.    Developer Source places all open windows on the 
screen. 

NOTE:    If only one window is open, it fully occupies the current size of the Developer 
Source window display.



Arranging Windows in a Cascade (the Cascade Command)
The Cascade command positions all open windows so that they are arranged in a cascade in 
the Developer Source window.    The active window appears on the top of the cascade.

To cascade windows, 

1.    Select the Window menu.

2.    Choose the Cascade command.    

Developer Source places all open windows on the screen.    



Arranging Windows in the Default Position (the Default 
Command)
The Default command positions all open windows according to settings predefined by the 
installation program.

To specify the default arrangement for all open windows, 

1.    Select the Window menu.

2.    Choose the Default command.    

Developer Source places all open windows in the default arrangement on the screen.    



Arranging the Icons (The Arrange Icons Command)
The Arrange Icons command allows you to automatically arrange all of the icons associated 
with the Developer Source application window. Choosing the command places all of the 
icons at the bottom of the Developer Source application window.

To Arrange the Icons,

1. Select the Window menu.

2. Choose the Arrange Icons selection.

NOTE:    The icons are only visible if the currently active document window (a window being 
displayed in the Developer Source application window) is not maximized.



Changing the Active Window (the List of Windows Commands)
If you are using the keyboard rather than a mouse, the List of Windows commands enable 
you to transfer the focus from one window to another (in other words, the new window 
becomes the active window--the window with the focus).    If only one window is active, only 
one command is listed.    The name of a window listed corresponds to its name as it appears 
in the window's caption bar.    A number precedes each entry identifying its order of 
appearance in relation to the other window. A check mark identifies the active window.

To transfer the focus from one window to another, thereby making it the active 
window,

1.    Select the Window menu.    A list of the open windows appears.

2.    Choose the window that you want to make active.

The focus switches to the window you chose.

If you have a mouse, you can change the focus by clicking anyplace inside the open window 
that you wish to make active.

 




